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What's New in V9.5

1 New General Features

1.1 CAM Layers Enhancement

When the part contains only one CAM layer, CAM Layers dropdown list is disabled on the
State Bar.

. T
Machine -
J] -~
" "
A
!
A
H—H
A
H—H
Mo Tool

1.2 Manual Nesting

Closing either of the Ask Part or the Instance Data commands is equivalent to exiting the
command.
In former cncKad versions closing either of these commands would still leave you in them.

1.3 Remove Wire Joint Command

This new command in the CAM Menu allows you for removing the Wire Joint command,
avoiding the removal of punches/cuts.

Cuk CaM L4

Punch CamM 3

Shear CamM r

Mill Cam C
[ Edit Cffsets

Set Offsets
Set all Offsets

%% Change Tool For Existing Punches Chrl4-T
& Edit Cam E
BE Add Microloink Shift+
(f;t: Remove Wire Joint -]

WR cot Tool Sequence

| | Zomman Cuks

[z Reposition and Transformation

'%' Push it {Chute)
Add/Remove Stop Machine

1.4 Rotation Angle in Polygon Shape

The Polygon Shape option in the Draw Menu allows you to enter the desired Rotation
Angle of the polygon and place it on the drawing already rotated.
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Size

A 5

B: B

M: lgi -
Angle: I 8 n

ak | Cancel |

For the above entered parameters, the polygon we place on the geometry will look this way:

1.5 Shape List Support in Report File

Now it is possible to implement the Shape List from Draw Menu into the Report File.

1.6 Changes in Printing

From now on, on Printing Tab of Workspace Settings you will be able to set the minimal
size (in pixels) for printed small shapes. This way they will always be visible on the paper.

Workspace Settings...

Dlizplay I b aterial I Usger Data I Wiorking Defaultz ] Pogt-Proceszor Options I Live Update ] Punch And Cut MW arnings ]
DFT Test | CAD Link Optiores | Bend Lines Printing

[ Frinted Shapes */ill be at least |30 pixels ]

1.7 Support For Black/White Printing From Simulation
Now it is possible to print the drawing in black and white in Simulation module.
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x]

Simulation Print

Frint bMode

* Graphics Preview

Line Thickness (W Black M/ hite ]

" MC [Test] Preview

] | Canizel |

1.8 Saving Files on Exiting cncKad

When you exit cncKad and a Part/Nest needs to be saved, cncKad will display it before
prompting the user to save it.

1.9 Push Out Icon Has Been Added

There is a new Push Out Icon in CAM Menu, providing you with easy access to the Push Out
dialog:

&

1.10 DXF Export Support for TRUMABEND
Now it is possible to export drawings as a DXF format to TRUMABEND Trumpf Machines.
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2 New Punch Features

2.1 Linear Turret Support
In version 9.5 it is possible to define a Linear:

M Edit Turret: YAGET. TRT {Read Only)

Turret Descripkion I B st

Edit Station

Station Number ID
Size
I~ Auto Indesx

I~ 50 Degress Only

= Round Only

Station Block

I jv

And a Turret Setup as well:
Il BUSS-BAR.CET

Tools' List:

Functions' List:

£dd Tool
Remave Taol
Change Tool
Tool Funchions. .,

Fix Staticn: i

Switch Ta Setup List

Radial Yiew: |

[ e | Close, Dontt save |

Linear Turrets are useful for machines such as Buss-Bar, Coil, and even some standard
machines such as the Amada OCTO.
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2.2 Spaces In Turret Naming

If you create a new turret and give it a name that contains spaces, the spaces will be
convertedto' ', e.g: “my turret” =>“my_turret”.

In the following example we saved a turret name containing spaces:

Lok, ir: | I3 Machines j =% Ef-
\ [)PreDefshapes 15LLTRT 201-A.TRT E
\_-'E§ GLTRT 18mul 2k krt 2012 trt E
My Recent 8LTRT 18MU.TRT 200mu.krk E
ElemimEns 9.TRT 18MU+L.TRT 20PLTRT B
rT 9LTRT 18mu-Master.trt 21ALTRT B
= 10.1RT = 191 TRT =) 2 1Fi3m bt B
Desktop 12AI-Master, TRT 20FI5-24,TRT 21fi4mt. brt B
_ 121.TRT | z0FL-a, TRT = 21FLTRT E
.___} 12IMT6, TRT 20FL-B,TRT 21FL-A,TRT E
e t 15.TRT 20FI-C,TRT 21FI-B.TRT E
#EOEHIETS ) 1120, et 20F1-D-Amada, TRT 21FI-C,TRT E
1612i trt 20FIMaster, TRT 21FI-D-Amada, TRT E
}jl)g 16Fi-a.trt 2014M3-59, TRT 21FIM1IS trt B
My Computer 18 TRT 2014M4, TRT 21FI-Master TRT B
18141 trt | 201, TRT = 21PAsLTRT E
Q < :
W 3
My MHetwork  File name: ( |ITI}' burret J j Open
Flaces
Filez of type: | Turret Files [* trt] j Cancel

And they were converted into "underscores":
Turret Setups ‘U° FINNPOWER I F525

b achine

Select the Machine: b achine

Select Setup File:

LASTSET.LUET

Save Setup Az ‘ Add/Create New

[

my_turret

Turret Dizplay ‘

Edit Setup ‘

Select Multi-Taals in Turret

| oy _kurret

[

Add/Edit TaolFunc ‘

Remove Setup ‘

Add/Create a
MHew Turet

Edit Turret

Femove Turet \

Cloze

2.3 Automatic Process AutoDestroy Sheet
A new automatic process supports destroying the sheet completely, leaving only a strip at the

clamps.
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2.4 Trim Sheet Changes

Now it is possible not only to trim a sheet with a laser tool, but by choosing the Side by Side
option you can choose more than one side of the sheet to be trimmed.

Fieposition ] Load/Unload ] Cutting O ptimization ] Split Skeleton ]
Sheet ] Auto ] Global Cut ] Cutting Parameters ] Part ]
Clamps ] Uszer Data ] Sheet Processing Technology Trim 5hest
[+ Trim Shest
Trim Sheet Taoal: BZ25
" Al Around
o TR
i i}
i1 S ANNN

-
* Side By Side

v Left v Right

San
|

IEEEEEEEEEEEH

v Top

[EEEEEEEEEESEEEEEE

k. | Cancel Help

2.5 Wire Joints Support For Arcs and Circles
In Add Punch dialog you can now add Wire Joints for arcs and circles.
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Add Punch

Funch Type

Mibble Chain
Mibble Contours
Mibble Start-End
Crunch

Crunich Triangle
Crunch Charnfer
Crunch &rc

Ginid

Single

Tool

( RO &

T ool Positioning

000

[ENTITY END

#

Tool Spacing Tool Sequence ]
™ Usze Tool Data
m I Directional Punch
1
Scall .
| ealop | [ Stop / Push Out
D2
Functions... |
[E Wire Jaint
v Perfarm
Iv AbLeast One +I|I+ +||I‘-
W ’_5 —HL—
ML: |30
I After First Hit
| Befare Last Hit
Cancel Help

And this will be the result on the drawing:

2.6 AutoPunch Support For Arcs and Circles

Arcs and Circles can now be automatically processed by rectangular tools, using the Prefer
rectangular Tools for Arcs/Circles option from AutoPunch Parameters tab of AutoPunch

dialog:
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AwutoPunch Pararneters lH-:uIes ] Slitting] Shapes1 Purich dnd Cut 'W'arnings]

: [mm]
Tools' Spacing Defaults-

P inimum T ool Owverlap:
Scallop For Round Tools:
Cutting Toolz Restrictions
b irvirum Width:

b asirnam Yfidth: 15

L

Crunching [Motches and Holesz]

Use Crunch Up To |300 Hitz

If More, Usze Shitting

| Use Only Toals Witk Available Die

¥ Prefer Rectangular Tools for &rcs/Circles

If Hitz Murnber Exceeds a0

¥ Holes [ Delete OId Before Funning

2.7 Use Oval Tools for Slitting

This new option of Slitting tab of AutoPunch dialog enables the user slitting the sheet with
oval tools.

2.8 New Tool Options

There are new features for handling tools:

2.8.1 Curving Tool Support For Trumpf
cncKad provides Curving Tool support for Trumpf Machines.

2.8.2 Changes in Tapping Tool Properties

In the Type Properties tab of Tool Data dialog of Tapping Tool a new section was added,
containing additional information for tapping tools:
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Tool Data- F TAPS54-M4.T

Common ] Allowed station sizes ] Cloze to clamp  Twpe Properties l

Pre-Punch

Speed

-
[v fith Extrusion

Effective Thickness

R atations

T[T

Top Dead Center

]
-

Cancel |

2.8.3 Warnings For Special Tools

Over Tonnage and Destroying the Part Warnings are no longer valid for Wheel, Tapping
and Forming Tools.

2.8.4 MultiTool Rotation

A new Key in the MDL file allows controlling the amount of MultiTool rotations near Sheet
Edge.

11
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3 New Laser Features

3.1 Vaporize Foiled Sheet

In the Cutting Parameters tab in Set Sheet and Clamps dialog you will find Vaporization
features, allowing you to work more efficiently.

Here you can choose whether to vaporize the entire sheet, a single cut or a pierce, before
processing the sheet with cutting.

In the past you could only set these options by adding vaporizing functions before the cut.
Now you can define in one place both their sequence and the vaporizing area:

[v Vaparization

Sequence

(@ \aporize Per Cut
(" Waporize Whole Sheet First

Apply on:
(& Whole Cut

(" Pierce Only

[+ Use Vaporize For Engrave

3.2 Path Finder (Adjust Tool-Path)

This automatic option calculates a path from one hole to another, avoiding passing over
already cut holes.
In the following examples you can see the utilization of this function:

o Before:

12
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e After:

After:

3.3 Handling Texts and Points in AutoCut

Now there is an option for the automatic handling of texts and points in the Technology tab of
AutoCut dialog.

Whatever choice you make, when cncKad recognizes unprocessed text or unmarked point it
will take action according to these definitions:

13
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.-'f-.utDEut] Global Cut | Cutting Optimization  Techhology ] Miu:r-:du:uint]
- Contaur Size Definition- i - OpendColored Contourz
kit GER i~ Engrave = T
olor ine Type
: 05 2
Small | ] iml ]
M edium: JD ]D Setz [ | ]
- Cut
: 2 33333
Lage. ] | Color Line Type
Setl [
Extra Large:; 1':' ]D F ] |
Ser2 [ | |
~Puzh Out -aAction For Undersized Holes:
[ Holes {" NONE
v MARK
[T Pars
" PIERCE
—&ction for Tesxt —action for Point
(+ NOME {* NOME
" EMGRAVE " MARE
" CUT " PIERLCE

3.4 No "Auto Tool Order" in Part Unloader
The Auto Tool Order option in Part Unloader doesn't apply for cutting.

14
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4 New in Tube Cutting
4.1 New Tube 3D Viewer

The 3D Viewer can now display edge cuts that were added manually, and not through Create
Intersection dialog.
This is an example of such a manual modification:

180
a0

4.2 Enhancement For Tubes Intersection
An intersection with a rectangular profile can now be done with a corner radius of 0.

4.3 New Model Key For Tubes

The "LimitAngleForPlaneCutting” key, inserted into .MDL file, sets the limits of the laser
movement for planar cuts, so that the beam doesn't stray away from the tube.

15
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5 New in AutoNest

5.1 AutoNest is Now an MDI Application

® MDI is an acronym for Multiple Document Interface.
This means that it is possible to open as many files as needed in main AutoNest window:

AutoNest ¥9.5.108 ‘N EUROMAC J MTX1250X2_TOP MTXROTMASTER my setup.NET

File Edt View Part Shest Grouping Mesting Settings Window Hslp

gEbES & | & T E Show Al aterials - £ T, T B e B G ot
G (@ oy R NETES T KEES %k &N SR

Order Infa g g 5 e T S]

Qnt: v 1800

rectangulart-la [rectangularz-la [rectangulari- \a rectangulars- \a rectangular- \a rectanaular?-la || Group Group
SubMest M “W 258 M !
Size ¥ [1500.00
Size v 1000.00
Sheets 1
Material
0 Steel 1 mm) -
=3
Efficiency 92.31% =
Number of Patts 59 LS
=3
Cursor =5
500.00 Y. 936.27 =
— — el RIS IR BT T BT Ly LT BT R Ly LT
e B S e R e e R
¥ ¥ & »f

Q

=

= & 0 Steel 1 mm)
= (1)1500% 1000
=1 (211500 1000
# & 0 Steel (32 mm)
Total gnt

9 [ [ [ [y

Click to select placement, click and drag to sslsct multiple placements. Right Click to shoot placement.

In addition to that, you can switch between the open parts from the new Window Menu, as
well as Tile, Cascade, etc:
Window W]

[

ascade

Ca
Tile
Arrange Icons

1 Ex_AUTOMEST\FILLERORDERSVALTONESTIDEMOZ . DSP* (SubMest 1 of 2)

2 Ex_AUTOMEST\FILLERORDERSVALTOMNESTLAUTOMNEST _G00D1.DSP* (SubMest 2 of 2)

3 Ex_AUTOMESTV\FILLERORDERSVALUTONESTIALUTOMNESTL.DSP (SubMest 1 of 4)
v 4 Ex_ALUTOMESTYFILLERORDERSVAUTONESTIDEMOGA_PUMCH.DSP (SubMest 1 of 23

S Ex_AUTOMEST\FILLERORDERSVALTOMNEST\DEMOL IWITHOUTSOURCE, DSP (SubMest 1 of 3)

There are also new features in the File Menu, allowing you to Save/Close not just one
window, but all of the windows at the same time:

16
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[enw k

CIpEn ¥
C|ose

I

E Save Ckrl4+3
Saye As Chrl+A
Save Al

o Export to CAD-CAM Files, .

5.2 Blanking in AutoNest
Blanking is the option of filling empty spaces in the nests. It is accessible from Nesting

Menu:
WEENEN Settings  Window  Help

P FRerun Current Subhest

[I# StartfConkinue AutoMest (Mexk Sheet)
&4, Fill holes
M Fill Holes For All Subnests

i Mest Report

= mew SubMest

H Delete SubMest

1 Delete All SubMests

Select Filler Parts

Fs Mext SubMest
<5 Previous SubMest
&1 Sork SubMests

Pt Rivets,

In the Create Blank Parts dialog you can enter various parameters for future space-fillers:

17



Create Blank Parts

+ Far &ll SubNests
" For Current SubMest

Buffer

Top |2
Botkamm |2
Left |2
Right |2
Policy

(¥ Max Tatal of Blanks

" Langest Blank

o]

X

Min % size for Blanking | 0

Min % size Far Blanking

The result will be similar to the one presented below:

5.3 Parts Priority in AutoNest

What's New in V9.5

1250.00

In the Part Information dialog chosen from Part Menu you are able to assign a Priority to a

part, giving an appropriate number:

18
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Part Information

X

Description |,:|E,-,-,,:,2_4
Path |I::"-.Metali:-:"-.P"'uE:-:_.-“-‘-.utl:uNest"mdemDE_ei.DFT
Area (sqm] 0.041 Eiies
) Farts' Buffer:
Perimeter [mm] 146E.18  Use Rect o B
Weight (KG] 0133 ze Rectangular B order

Part Size: % 39279 Y: 12313 o O
bir Gt 28 l— l—

o Ot o {* |Jze Part Border
ax [n

Buffer Size: 5
Directionz A iy -

[ Thiz Part |z Treated Az Found | T Use Special Buffer Edit Buffer... |

[ Filler Part Holes' Buffer: lui

[w Mirror Allowed

M aterial
Type | 1 Alurninium ﬂ

[ Lock Part
Bin/Pallet Mumber

Thickness 11.20 =]  Update from DFT |

( Priority |1 ] Common Cuts
Part's Usger Data Yertical Mone  +| Distance:

Edit Part Harizontal Mome  +| Distance:

| There iz no ather machine that zupportz unload

—
—

Center Description

Print B epart

Update Part

s | Cancel

While running Start/Continue AutoNest option you will be able to choose whether to Use
Part Priority or not.

If you choose to utilize this during subnest creation, you will be able to decide how to handle
the priority — for new or already nested sheets:

Start/Continue AutoNest

AutaMest Parameters Autohest Direction - [v Use Part Prionty
i~ Mesting Strategy | Origit; Bottorn- Left - Mest Priority handling
{+ Rectangular Nesting =
_ it Left - Fight = Take new sheet(s]
" True Shape Mesting * Ty to fit on already nested sheets
- Botl —_—
—_—
o —
™ Use Best Sheets Sheets Quantities I i

I Gererate Multiple SubMest

Advanced... - % F:% U
Start J Cloze |

19
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5.4 Labels Report

Now it is possible to create Labels Report from Settings => Report Settings => AutoNest
Labels Settings:

Report Settings Dialog

cnckad Repaort Sethings ] AutoMest Report Settings  Autonest Lables Settings l

Report Language: iEnglish _'J

Template File For Lables Order Report:

RPT_AM_LB_Eng_3657_Bar_Drawhl,doc

RPT_AN_LE_Eng_3657_DrawM.doc

RPT_AMN_LB_Eng_3657 _Fhame.doc

RPT_AN_LE_Eng_3666_REar_Drawh,doc
RPT_AMN_LE Eng 3666 DrawM.doc

RRT_AMN_LE Eng 3666 Fhlame.doc

oK | Cancel I Help |

Later on you will be able to print preview and print a Labels Report:
Print Preview

Choose one of the Fallowing:

" User Report -
{

~

~

SO

({;‘ Order Lables Repart ]

Ik Cancel |

That's how the printout will look like:

20
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SuUs-10-112 SUS-10-112 SUS-10-113 SUS-10-113
SuUS-10-121 SUS-10-126 SUS-10-115 SUS-10-115
SuUSs-10-115 SUS-10-115 SUS-10-115 SUS-10-115
SUSs-10-115 SUS-10-115 SUS-10-115 SUS-10-115
SUSs-10-115 SUS-10-115 SUS-10-115 SUS-10-115

You can also create labels with bar code:

315796578 315796578 658923575 858923575
THTITTT) (TR A [T

13458571 546879952 258963147 258963147
IIIIIIIIIII AR LT LI
256963147 256963147 258963147 258963147
LTI L LI LT
258963147 258963147 258963147 258963147
[LITTITERT LTI LT LI
258963147 258963147 2589637147 258963147

5.5 New Tokens in AutoNest

A few new tokens such as P. WEIGHT_GROSS and P_WEIGHT_GROSS_ SN have been
added to AutoNest.

5.6 Reports' Print Preview for Several Subnests

It is possible now to view Reports' Print Preview for several subnests at a time. In previous
versions this option was available only for printing:

21



What's New in V9.5

Print Preview

]

Choose one of the Following:

{* Lser Repark "
" For Order

" For Current subniest

{* Between the Following

Frarn 1 To 2

" Crder Lables Repart

After the reports are created you will receive the following message:
AutoNest V9.5 (%]

Created Reaport Files Are:
! i iMetalixPYEx_AutoMestiFillerorderst Autoflest\DEMOZ001 D
CiMetalixdPhEx _AutoMestFillerOrdersautoMest\DEMOZ002, DT

5.7 New Default Exported Filenames Template

In Working Settings on the AutoNest tab you will find new templates of Exported File
Names:

Settings

E3

AutoMest ]‘W’Drking Defaultﬂ Material] Faost-Processar Dptiu:un&] Live Update]

Minimal Hole Dimenzions J1

Exported Filenames Template

|<EIldetName><3DigitsFiHed>.<EHt> ﬂ

[ Abwaps Break Grouped Arays When E <part
[ Don't Create Grouped Arays in Auto Process
Default Subnests Sort Mode-
" Mot Sorted
f* From Smallest To Biggest

 From Biggest To Smallest

When you export parts from AutoNest to cncKad, choosing one of the following templates
from dropdown list will determine the exported files naming in cncKad:

22
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Esported Filenames Template

<
<OrderMarmes-<katy-< Thks--<SubM esthum: <Ext:
<OrdeMame: <DashedSubMestsMum3s: <Ext>
<OrderMarmes < 30igitsFived: <Ext>

¢OrderMames <40 igitzFiwed: . <E xtx

T O 20meEd

5.8 Changes in DFT Files Creation

Each part imported to AutoNest has its own description (in available in Part Information
dialog):

Part Information

Description ||:|err||:|2_4 J
Path |E:'\I'-.-1etali:-:'\P"\E:-c_.-’-'-.utu:uNest'\.demDE_d.DFT
Area (sqm]  0.041 ELies
) Partz' Buffer:
Perimeter [mm) 146618 £ Use Rect a1 Bord
Weight (KG] 0133 ze Rectangular Border
Part Sizer = 39273 Y. 12313

If in your nest there are two or more parts with the same description, in Part Information
dialog you can change their description before creating DFT files for them.

5.9 Divide Button Added to Parts List dialog

In the Part List dialog a divide button was added:

Part Address lMin cnt | ax Qn[ hiaterial |ThickneIWnrk Orderl Group |EIin.lP[Priori| Depos'rt| Depos
1 EX_aAUTONEST'FILLERORDERSAALTOME [ 25 25 Steel 1 0
2 EX_ALTOMESTFILLERORDERSWLUTONE | 25 25 | Steel ' ' ' [ o
3 EX_AUTOMESTFILLERORDERSWLUTONE | 25 | 100 | Steel 1 o
4 EX_AUTOMESTFILLERORDERSWUTOME | 25 | 100 | Steel 1 o
5 EX_AUTOMEST'FILLERORDERS\BUTOME | 25 | 25 | Steel 1 o
6 EX_AUTOMESTFILLERORDERSWUTOME | 25 | 25 | Steel 1 o
7 EX_AUTOMESTFILLERORDERSWLUTOME | 0 10000 | Steel 1 o
£ >

Prirt ] | Cancel I

5.10 Change Subnest’'s Material

Now it is possible to change materials for chose subnests. Select the subnest for which you
want to change material, and click the right mouse button. In the dialog which will appear you
will be able to choose Change Material option:
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el
—-&2 0 Steel [1 mm) 2 =
(1) 250

5]
[=] (212500 ¥ Delete

Tatal gnt . o
Set as active Material filker

wer Generate MST Files

oir Generate DFT files

Generate N For selecked

Change Material

Clicking it will result in opening the following dialog, from which you will be able to pick your
subnest's new material:

Material | 1 Aluminium ﬂ

Thickress | 1.20 -

ol 4 | Cancel |

5.11 Efficiency Calculation Considers AutoCutSheet

Efficiency calculation takes unto the consideration the used space of the sheet space cut with
AutoCut Sheet option:

5.12 Rotation Placements

When you move a part while placing it on the nest you can rotate it using "+" and "-" buttons.
This allows you for more efficient space usage and is more accurate placing tool.
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6 Estimation Module

6.1 Cost Estimation Support for Nest

There is a new item of Estimation Menu provides costing and timing estimation not only for
Current Part, but for Current Nest as well.
RN Setkings  Window  Help

Estimation Settings
(_Estimatin:-n Far Current Park/Mest -]

Estimation for Generic Part

6.2 Gas Pricing in Time Estimation Settings

For cutting machines there is a new item of Gas Prices on General Tab in Time Estimation
Settings:

Time Estimation Settings

General | additional Time Constants ]

Preparations

Engineeting Price/Hr lﬂ—
Default Engineering Time 01:00:00 —
Programming Price/Hr |4EI—
Defaulk Programming Tirmne Q0:00:00 =

AMADA | FO_PIPE

Setup Price/Hr 100
Defaulk Setup Time 00:30:00 —
Machine PriceHr 100
r -
2as Prices
Price Per m™3 Price Per Ton
Nz 07 | 598.2906
02 086 | 64323111
sir 0,05 | 41.42502
L F
zeneral

Price Precision ]

(04 | Cancel | Help |

6.3 Changes in Estimation Dialog
There are a lot of changes implemented to Estimation Dialog. Its outlook changed completely
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— instead one huge window you will see tabs sorted according to their content:

6.3.1

Estimation Summary Table

The estimation data appears both in a summary table that describes the main information for
each part, and additional summary information related to the entire nest such as: total
efficiency of material usage within the nest and the material cost for each part in the nest,

derived from the calculated efficiency.

Current Part Estimation

Estimation Summary Table lSingIe Patt Casting ] Patrt Processing ] Part Extra Work] Machine ]

Machine |'X' AMADA | FO_PIPE  NONE

Material Tvpe

=

Part }C:'I,Metalix'l,P'l,Ex_.ﬂutoNest'l,DemoPunchs.DFT

Efficiency % {Total Area of Cuter ContoursfSheet Area) |60

Thickness

Feed Potentiometer (%) | 100

fo = ¥
’—4| Recaloulate

Reset Columns width |

Tokal Job Cost

Without Material

Including Material

Cost
1558.0342

168,9542

; | cuting | cutting Cost  Total 1 Total | Total
Fart Wieight | Material | - Cost Per : ; Total Cutting | Total : Total Cost
Patt Matne Time Pet | Cost Per Withot Guartity | Cutting . Material | Gasz - | Total Cost
il Cost Cost Part Cost Wikt Mo Material
H Gross | | eat Pat | %% | Material | Time ° S Cost | Cost]
" _DemoPunChB 0.75 0.546 _00:03:1 4 :5.40'1 Fa _D :5.401 Fal :5.94??'1 :20 _U1 :04:49 :1 05.03422 _1 56 :1 0492 _D :1 05.03422 _1 1 8.95422_
Sheet Properties
Effective Sheet Area ¥ | 2000 y | 1000
Marginal Caost {(withaut fix cost) Job Fix Cost
Price Cosk Price Cosk
Cutking Machine Ti 01:04:49 100.00 Per Hour 108,034 —
utting Machine Time Job Setup Time 00:30:00 == 100,00 Per Hour S0
Used Material 15.8 kg 0.70Perkg 10,92
additional Process Time 00:00:00 100.00 Per Hour 1]
Used Gas a
Total Without Material | 105.0342 Total | 118.9542 Total |50

% Overhead

4

4z

Preview Estirmation Report ‘

Prink Estirnation Repork |

o]

Cancel | Help |

6.3.2 Single Part Costing

Single part costing mode provides the ability to estimate the part in a “stand alone” mode (i.e.
not as a part of the nest). This option is available also for a single DFT geometries.
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Estimation

Estimation Summary Table Single Part Costing lPart Processing | Part Extra \Work ] Machine ]

Machine | AMADA § FEGA3ST 56l w|  Material Type

Part }C MetalixiPYEx_AutoMest\DemoPunche, DFT Thickness r Recalculate

Feed Potentiometer (%) | 100

Fix Cost Part Properties -

Cost Bounding Box
Engineeting Time 00:00:00 —2- £0.00 Per Hour 1] 357 v 1955 e

* i
Programring Time 00:00:00 =2 40,00 Per Hour o

Machine Setup Time 00:00:00 =3 60,00 Per Hour o Area of Quter Conbour (A0C) | 0.0604 m™z
Area Met | 0.0452 mz
Marginal Cast {withaut fix cost) |
Cost Weight Met |0.3525  ka
Weight Gross 0.4708 kg 0,70 Per Kg | 0,32958
Material Calculation Parameters |

Total Cutting Machine Joo:ot:38 60.00 Per Hour 1.64156 Material Waste Rate % ]D EFfiianey o oo
Used Gas o Area Caleulation Method

(" Bounding Box

+ Cuter Conkaur

Area Gross (Area + Waste) | 0.0604 m"2

Results

Guantity 1 10 100 1000 20

e 1.97114 [1.97114 [1.97114 1.97114 1.97114

Without material 1.64156 11.64156 11.64156 1.64156 1.64156

Ok | Cancel Help

6.3.3 Part Processing

Here you can see the processing time details for each part in the geometry.

Estirnakion Surnmary Table ] Single Part Costing  Part Processing ] Part Extra Work ] Machire ]
Machine | EUROMAC | MTX1250%2_TOP MTROTMASTER x| Material Type o st =l
Part }C:'I,Metalix'l,P'l,Ex_nutoNest'l,DemoPunchs.DFT Thickness | _J Recalculate |
Feed Potentiometer (%) | 100
Processing Amounts Processing Time

‘Wapotization Length | O T Yaparization Time ED:DD:DD

Engraving Length |0 o Engraving Time {00:00:00

e Ry ’D— Pietcing Tirne ED:DD:DD

i e Cutking Tirme: EU:DD:DD

utting Length | o mm
Punching Time n0:00:23
Punch

thet et Z Time Jo0:00:00

Travel Length |8342.87  mm ®Y¥ Travel Time 00:00:23

Tool QTY |8 Takal Cutting Machine Processing Time  jo0:00:46
[a]4 ‘ Cancel Help

6.3.4  Part Extra Work
This tab allows the user to setup the extra processing types and estimate their time and cost.

27



What's New in V9.5

Current Part Estimation

Estirnakion Surnmary Table ] Single Part Costing 1 Fart Processing  Part Extra Work ]Machine ]

Machine |2 TRUMPF [ TCL30305 TRUMPFT o] Material Type [0 o= =

Part }C:'I,Metalix'l,P'l,Ex_AutoNest'l,DemoPunchﬁ.DFT Thickness 1.00 ' Recalculate

1 Cosk Per Park
CQuankity TimefUnit Cost Per Hour Time: Cost
W Grinding 40 W ]
™ Driling 14 [omooio = 40 poiozizo p.sssse

HE B

I¥ Tapping o000 == 40 ﬁu:no:un ]
v Bending 01500 = 20 L1500 25
Total brii7zo 2655558
-Fix Cost
Cost Per Hour Time Cosk

I¥ Bend Setup 30 00:25:00 —5 12.5

OF | Cancel Help

6.3.5 Machine
This tab provides you with the information on the machine you work with — its working data
and technology parameters.

Current Part Estimation EJ

Estimation Summary Table ] Single Part Costing 1 Part Processing 1 Part Extra Work Machine ]

Machine |'¥' BYSTRONIC j BY-NEW NONE x| Material Type [0 stee ]

Part }C:'I,Metalix'l,P'l,Ex_AutoNest'l,circuIar1-Iaser.DFT Thickness ‘ i _J Recalculate |

- Cutting Data - Cutting Speed - Technology Parameters:
Feed Set
Cutting Speed | 8100 mimymin small-Pulsed 60
Vaporization Speed | 3000 mmn/min Mediurn-Macrol

Engraving Speed |[8200  mm/min Large-Ci &100 1

Alarge

117
JHN

Ok | Cancel Help |'
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7 New in CAD Link
7.1 New functions in SolidWorks and SolidEdge

In SolidWorks and SolidEdge there are two to new functions to traverse assemblies or single
parts silently: SW_StartTraverseWithOptions and SE_StartTraverseWithOptions. They are
accessible through the PartReader automation interface. They allow the programmer to export
entire assemblies from the Solid program to cncKad without requiring intervention from the
user.

7.2 SolidEdge Assembly Enhancement

There is a new function in SolidEdge Assembly, allowing you to open Settings Dialog directly,
instead of entering Material Properties dialog first.
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